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6.1 Objectives 
This unit will cover advanced features of the MS Word.  After reading this unit, you will be able: 

 To create list and tables, 

 To understand uses of review tools, 

 To learn about adding picture, ClipArt, and 

 To learn about the mail-merge process. 

6.2 Create Bulleted and Numbered lists 
 

You can improve display of list by adding bullets or numbers in the starting of each item of the 

list. Bulleted list have bullets or icons in the beginning of the every entry of the list, similarly 

numbered list have numberor alphabets in ascending order at the starting of each entry of the list. 
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The outline list combines bullets and numbers formats to display list in the document. The 

outline list is also known as multilevel list. Option for creation and editing of various types of list 

are available under the Paragraph sub-group of theHome tab of the ribbon. 

 

 
 

Fig. 1 

 

You can add bullet or number at the starting of each entry while typing a new list or these can be 

addedto the existing lists. Just click on Bulleted list,Numberedlist or Multilevel list icons 

before typing the list, now bullet or number is automatically entered as you press enter to add 

new item to the list. Once you finish the typing of the list, click again on Numbered List or 

BulletedListicons to finish the numbering/bulleting of the list. Now typed contents will be added 

as a paragraph. You can add numbers or bullets to existing list by selecting the entire list to be 

numbered or bulleted and then click on one of the options i.e. Numbered list, Bulleted list or 

multilevel list.  

 

You can edit a list at any time. First select the portion of the list to be edited and then type the 

revised entries. When you click over the icon of Numbered, Bulleted or Multilayered 

listoptions, the list is displayed with default bullets or number style. If default style does not 

meet your requirement then click on arrow key () next to icons of Numbered list, bulleted 

listor multi-leveled list to select one of the styles to make the list more attractive. 

 

6.3 Create a Table  
 

First insert amply blank space at appropriate in the document to accommodate a table.Take 

cursor to the position where you want to insert a table in your document. Click on the Insert tab 

from the ribbon, then click of Table icon ( ) under Tables sub group. You get a window like 

this on your desktop.  

 

 
Fig. 2 

Numbered list 

Bulleted list  

Multi level list 
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You can draw a table by dragging mouse pointer on the boxes listed in the form of grid under the 

Insert Tablelabel. Drag mouse on desired numbers of rows and columns. A table with number 

of rows and columns dragged over by you is inserted in the document as you release the mouse 

button. You can also click on Insert Tableicon.  You will get the following dialogue window to 

insert a table in the document. Enter number of rows and columns needed in table in appropriate 

textboxes. Click on OK button to insert table in the document.  

 

 
Fig.: 3 

 

Enter Data in a Table: Place the cursor in the cell, where you wish to enter the information, 

cursor blinks in the left corner of that cell.Typed text is inserted at the position of the cursor. 

Once you reach right end of the cell, text automatically moves to next line in the same cell.When 

you are typing in a table or have focus on table, notice two new tabsTable Design andTable 

Layout appeared on the ribbon.Commands and functions of these tabsmodify the structure and 

format of the table. Commands and functions of the Table Design tab are grouped into three 

major subgroupsi.e. Table Style Options, Table Styles and Draw Borders.   

 

 
 

Fig. 4 

Similarly, Layout tab of table has six sub commands i.e. Table, Rows & Columns, Merge, Cell 

Size, Alignment, and Data. The Table subgroup has commands to select specific cells, rows or 

columns, to view or hide thegridlines and set the properties of the tables. The Rows and 

Columnssubgroup has commands to inserts and deletes rows or columns in the selected table. 

Select the cells, rows or columns to be deleted andthen click on Delete icon under the Rows & 

Columns subgroup, you will get the following dialogue box, to select appropriate options to 

complete the deletion. 
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Fig. 5 

 

The Merge subgroup of the Table Layout tab mergesor split cells of the tables. The Cell Size 

subgroup of the Table Layout tab increases or decreases the width and height of cells, rows and 

columns. The Alignment subgroup offers options to align texts in cells, set margins and change 

directions of text in a cell. Commands in all these sub groups of Table Layout tab i.e. merge, 

cell size and alignment are applied after selecting the cells to be changed. People could not make 

sense of data in a large table spread over a number of pages without referring heading of 

columns of table typed on the top of table. The Data subgroup of the Table Layout tab offers 

command to repeat header rows of the table automatically on every new page, when table is 

displayed on monitor or printed on paper.  This sub group also offers command to sort entries of 

the table. The commands of the Table Designand Table Layout tabsare self explanatory and 

easy to use. Select appropriate numbers of rows, columns and cells and apply commands listed 

under Table Design and Table Layout table to improve the style of table.  

 

 

Fig. 6 

Procedure to sort data of a table is explained below: 

1. Select cells/rows/columns of table those you want to sort.  

2. Click on Sort icon under Date subgroup of the Table Layout tab, you will get the 

following window. Select the field name/column used to sort entries of the table, under 

combo box of Sort by label. It type is automatically reflected under Type label. You can 

change the type of data by selecting one of the listed types under the combo box. 

 

Fig. 7 
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3. Under My list haslabel, decide whether the first row of the table has data or it acts as 

header for the data.  

4. When you select Header row Option. The header row is not included in the sorting 

process in such a situation. If you have opted for No header row option then combo box 

of the Sort by label lists columns of the table  as column1, column2, column3 etc.  

5. Decide whether data is to be sorted in Ascending or Descending order with radio button.  

6. If  data is to be sorted further on other fields then repeat steps 4 and 5 for Then by field  

7. Click OK to execute the sort command 

 

6.4 Type Special Characters 

Alphabets of foreign languages, mathematical symbols, other popular signs and symbols cannot 

be entered in document with the help of keyboard. You can insert these alphabets, signs and 

symbols in document by clicking on Symbols icon of the Symbols sub-group of the Insert tab 

of ribbon.  

 

Fig. 8 

You will get a list of special characters/symbols used recently by you under the Symbol label, 

click on symbol to be inserted at the position of cursor. If symbol desired by you is not listed in 

recently used symbols then click on More Symbols … option, special symbols are listed in a 

separate window as shown below.  

 

 

Fig. 9 
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Click on the symbol to be inserted, and then click on Insert button of the dialogue box. The 

selected symbol is inserted at the position of the cursor. If symbol desired by you is not listed 

then look for the symbol in different fonts by selecting new font style from the combo box of the 

Font: label. 

6.5 Create a template  

A template is special document that serve as starting point to draft a new document.  A template 

under the MS Word 2007 is identified by its extensions i.e. dotx or dotm (a .dotm file type 

allows you to enable macros in the file). Templates are pre-formatted documents. You can design 

a template for business correspondence with name and logo of the company in the header of 

document, predefined page layout and dimension as per office stationary. Sections, fonts, 

margins, and styles of documents are directed by business ethics and practices. You need not 

define structure and format of business letters, every time you draft a business correspondence. 

You can find pre-defined Word’s templates by clicking on the Office Button , click on New 

option, various template categories are listed in the window on the left pane. Select one of the 

template category, templates from that group are displaced in the middle pane and right side pane 

display preview of the template highlighted in the middle pane. Select the appropriate template 

and click on Create command button. New document adopts the structure and format of the 

template opted by you.   

 

Fig. 10 

When predefined templates failed to meet your requirement then define your own template. 

Create a new document set its header, footer, margins, paragraph, line spacing, company name 

and logo in header/footer, watermark logo and other styles options. Once you are satisfied with 

the style of the document then save it. Click on Office Button, take focus to Save as option, 

click on Word Template, define the name of the template and click on save option to store as 

document template.  
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6.6 Track Changes  
 

Track Changes is a powerful tool for editing a document. It highlights changes incorporated in a 

document while revising that document. Tools for tracking the changes in the document are 

grouped in the Review tab of the Ribbon. However, the track change facility is not available for 

documents by default. You have to instruct the MS Word to keep tracks of changes in the 

document. To instruct you computer to keep records of changes in the documents, click over 

Track Changes option under Tracking sub-section of the Review tab of ribbon. Track change 

enable attribute of a document is indicated on the status bar as ‘Track Change: On’.  If this 

notification is not reflected in the status bar even though have enabled track change then you 

need to customize the status bar to reflect the status of track change option. Right click over the 

status bar and select the check box of Track Changes option. The track change attribute of a 

document in the status bar is displayed as shown in fig 11. 

 

Fig 11 

Once, MS-Word starts tracking changes in your document. You can view changes in four options 

under the combo box of the Display of Review option ( ) under theTracing sub-group of 

Review tab.  

 

a) Final Showing Markup: This option shows the final document with changes highlighted 

 

b) Final: This option shows the final document, without marking up changes. 

 

c) Original Showing Markup: The original document with changes highlighted, and 

 

d) Original: The original document without making up changes.  

 

 

Fig 12 

The Show Markup feature filter changes so that you can view specific kinds of changes in the 

document. Changes in documents are categorized on the basis of nature and area of changes into 

Comments, Formatting, Mark-up, Insertion and Deletion etc. under the Show Markup option. 

Click on triangle () next to Show Markup label select each option and see the difference in  

display. If your document is reviewedby more than one reviewer/author then you can see 

changes made by individual author/reviewer separately. Focus pointer on Reviewersoption of 

the Show Markup icon, list of all reviewers is available as cascade menu. Select the specific 

reviewer’s name and see the changes made by him/her.  
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While reviewing the changes made in document, you can accept or reject changes made in the 

document by using AcceptorReject options from Changes sub-section of the Review tab. First 

open the final document with all changes listed with Final Showing Markup option from the 

combo box of Display of Review. Select a specific change by clicking over it and then decide 

whether to accept or reject the selected change.  

   

Fig 13 

You can add comments during the revision of your documents.Text of the documents remain 

intact after adding or deleting comments from documents.  Comments are written as a separate 

note, added at the extreme right corner of the document beyond the right margin of the text. Text 

where you have added comments get highlighted with gray colour background. A document with 

added comments looks like this. 

 

Fig 14 

Important issues,shortcomings and text need further clarification can be highlighted with the help 

of comment function, so that commented text would be paid attention later. Comments can be 

added by first selecting the text for which you want to add comment then click over New 

Comment( ) option under Comments sub-section of the Review tab. A blank text box is 

added at the right end of the document with cursor blinking atthe extreme left corner inside the 

comment box to type a comment. Typed comment appears in a text box, click outside this 

textbox in the document window after typing comments.   

Accept Reject  
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Fig 15 

Comments can be deleted from the document, by selecting the comment to be deleted, clicking 

on Delete option from the Comments subgroup of the Review tab. The background of the 

commented text changes to normal. 

 

6.7 Spelling and Grammar Checker 
 

Spell and grammar checkertool is a powerful feature of the MS-Word. This tool checks spelling 

and grammar of the entire documents including hidden texts, text in boxes, header and footer. 

Click on Review tab and then select Spelling & Grammar tool ( ) from the Proofing sub-

group to initiate checking of the spelling and grammar of the documents. The checking starts 

from the position of cursor, goes to the end of the document, and starts again from the beginning 

of the document till the position of the cursor in the document, where you have initiated this tool. 

Later it checkscontents of the header, footer, and textboxes and hidden texts. The following 

dialogue window appears over the screen while Spelling and Grammar tool is functioning and it 

notices any error in the document. 

 

 
Fig 16 

 

You can decide whether you want to check both i.e. spelling and grammar of the document or 

just the spelling in the document. If you are not interested in checking the grammar of the 

document then clear the check boxof Check grammaroption. If this box is checked then the 

Checker tool will check both grammar and spelling of the document. Whenever, the Spell 

Checker tool encounters any spelling and grammar errors in the document, it highlights the text 

with mistake in the document in the upper window of the spell-checker tool labeled as Not in 

Dictionary: and makes suggestions from the dictionary, to rectify error, in the lower window 

labeled as Suggestions. Select the appropriate correct word from the various suggestions, listed 

in lower window, click on Change button to replace incorrect text with word highlighted by you.   

The Spell checker also offers alternatives to Change button such as Ignore Once, Ignore All, 

Add to Dictionary and Change All. These options are self-explained. The Change All option 

rectifiesall the repetition of the highlighted wrong word with words suggested by you,in a single 
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stroke throughout the entire document. The Ignoreonce option retains the wrong word 

highlighted by the Spell Checker only for this instance. The Ignore alloption retains the word 

highlighted by spell checker as wrong, throughout the document, later on this word is not 

highlighted as wrong in the document. You can exclude specific words from checking by 

specifying these words as not to be checked by the spell checkers. The spell checker treats these 

words correct in future. This facility is useful when your document include foreign words or 

proper noun reflecting names of places, animal or person in the documents. These words are not 

listed in dictionary maintained by MS-Word. The Add to Dictionary option adds the highlighted 

word todictionary, treats it correct in future, and never highlights it again wrong. You should be 

careful in adding in a new word to dictionary, if you add word with wrong spelling to dictionary 

than spell-checker would treat it as correct and do not flag it wrong in future. 

   

The spell check has limited capacity; it could not understand the context in which specific words 

have been used in sentences. During the grammar check, the tool identifies sentences having 

grammatical or stylistic errors and it makes suggestions to rectify error and improves the 

meaning of sentences.   If you could not understand, how to rectify grammar errors highlighted 

by the Spell Check and need further explanation and assistance to understand the error then click 

on Explain option.  The Spell Checker offers detailed assistance on highlighted grammar error in 

a separate window.   

6.8 Thesaurus 

 
The thesaurus can be used to make document more impressive. It offers alterative words with 

similar meaning of the selected word. To find the alternative words (synonymous) of the specific 

word, first select the desired word and then invoke Thesaurus fromProofing subgroupsof the 

Reviewtab of ribbon or by pressing Shift + F7shortcut after selecting the work for which 

alternative wordsare to be identified. The Thesaurus cannot understand the context in which the 

original word is used and how alternative words can change the meaning of the sentence. 

 

 

Fig 17 

Thesaurus 

Spelling & Grammar  
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The MS Word software has provision to check and correct grammar and spelling mistakes 

automatically,while typing of document. It automatically replaces incorrect word with 

appropriate correct word, when Autocorrectoption is active. Some time, you type words from 

foreign languagesor proper noun in your documents, thus you do not want MS-Word to treat 

these words incorrect and automatically replace these words with correct word from dictionary. 

You can customize autocorrect habit of the MS Word application through Word optionbutton in 

the Office Button.  

 

 Click the Office Button  

 Click the Word Options button, a new window appear on the screen 

 Click on the Proofing tab, get the following window 

 

 
Fig 18 

 

 Click on theAutoCorrect Options button and get this window  

 

 

Fig 19 
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Add specify words, which are frequently typed wrongly by you, exactly in the way typed by you, 

in textbox under Replace label and type the corresponding correct word under With label. Click 

on OK button to add it in autocorrect list. Now, whenever you type any of the words, place 

under Replace category. It gets automatically replaced with corresponding words from the list of 

Withlabel. MS Office also supports dictionaries for regional languages. These dictionaries can 

be used for checking of spelling.  You can change default dictionary to Regional Languages in 

the MS word, with following steps.  

 Click on the Office Button  

 Click on the Word Options Button at the bottom of Office Button menu. A new window 

appears over the screen. 

 Click on the Proofing tab  

 Click on Custom Dictionary…button , you get this window  

 

 

Fig 20 

Select one of dictionaries from the list of Dictionary language Combo box. Click on OK 

command button to apply the selected dictionary, which is to be used for spell checking. 

Unfortunately, MS-Word does not provide dictionary support for regional languages of India, 

however, the C-Dot, an autonomous body of the Government of India, promoting uses of 

computer for regional languages offer dictionaries for Indian languages, which could be easily 

embedded in the MS-Word or other popular word-processing software. You can add words of 

regional language in dictionary, by clicking on Edit Word List type new words in textbox, click 

on Add command button to add new words in the customize dictionary. 

6.9 Hyphenation 

The Hyphenation feature allows you to break long words into lines. This facility is frequently 

used by publishers to make the spacing between words uniform and keep the ends of lines on the 

margins of the page. Hyphenated break of word is reflects through hyphenation symbols, (-) at 

the position of break. The hyphenation mode can be switchon by clicking on Hyphenation 

option under Page Setup subgroup of Page Layout tab of the ribbon. MS Word allows 

hyphenate of words either manually or automatically. When you click over the Hyphenation 

icon, you have to decide whether hyphenation will be added manually or automatically. A tick 
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mark appearsagainst hyphenation label on the ribbon,when it is on. Now long words are broken 

between lines. 

 

Fig 21 

6.10 Headers and Footers  
 

The top and bottom parts in a document beyond its contents are called header and footer of a 

document respectively. The information placed in header and footer is repeated on each page of 

the document, in the printed copy of the document. Contents of header and footer are not 

reflected while you are drafting the document. The header is primarily used to displayname and 

logo of organization. The header may also include other information such as location of folder, 

where document is saved, page number, date/time etc. The contents of header and footer are 

independent of each other and designed independently. You can either have the same 

information in header/footer areas of each page of the document or have separate header and 

footer for each section of the document, or have separate header and footer for odd and even 

pages. Certain components ofheader and footer change on everyconsecutive page for example 

page number changes in incremental order on each page.  

 

You can add contents to header or footer in a document by selecting corresponding icons 

fromHeader & Footersub group from the Inserttab of ribbon. When you click on Header or 

Footer icon, it shows predefined text and formats, which can be used as header or footer. You 

can select one of predefined header/footer or you can define your own headerformats by clicking 

on Edit header icon in fig. 22. Similarly, you can define footer for your document. You can 

either adopt predefined footer or design your footer by clicking on Edit Footer icon. 

 

 
Fig 22 
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6.11 Add page number   
 

You can add page number either in header or in footer area of the document. As your document, 

grows, MS Word automatically assigned next page number to every new page. You can set the 

position for display of page number in the footer or heading. It may be inserted at the left, centre 

or right corners of the page.  

 

Click on Insert tab of the ribbon, click on arrow () next to Page Number Icon under the 

Header & Footer subgroup. Decide whether page number is needed at the top or bottom of the 

page, accordingly take mouse pointer focus to listed option, a cascade menu displays various 

predefined style and format for inserting page number and select one of the options to insert page 

number.  

 

 
Fig 23 

 

Page numbering by default is shown in number form i.e. 1, 2, 3, 4 etc. If you want to use roman 

or alphabeticcharacters for numbering of pages then select appropriate page number format. 

Click on Insert tab of the ribbon, click on arrow key next to Page Number icon under the 

Header & Footer subgroup and click on Format Page Numbers option, you will get the 

following window. 
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Fig 24 

Click on the combo box of the Number format: label and set the format of page numbering by 

selecting one of the options. You should select various options from this list and see the impact 

of each option on the formatting the numbering of pages. You can start numbering of pages 

either from the first page (default) or from any other page as specified by you. You have noticed 

that people usually avoid numbering on pages, used to display title of document and index of 

contents/chapters or acknowledgement-report of the document. If you want to start numbering of 

pages from specific page than enter that page number in the textbox facing Start at label under 

the Page numbering frame of the Page Number format dialogue window shown in fig 24.  

 

You can set the dimension of paper for printing of document. The size ofpaper in a document is 

set only once. Entire contents of document are automatically adjusted as per the size of paper set 

by you. There are standard notions to define the size of paper such as A3, A4, A5, legal, 

executive etc. Each notion specifies a specific size of paper. You can select one of the predefined 

sizes of papersby clicking on arrow () next to Size icon ( ) under the Page Setup 

subgroup of the Page Layout tab of the ribbon. As you setthe size of paper, the text of the 

document is adjusted automatically.   If size of page needed by you for preparation of document 

is not listed then more options to define the size of page are available by clicking on More Page 

Size option available in the listing of Size option ( ). A dialogue window allows you to 

customize the sizeof page as you click on more page size option. 

 

 

 
Fig 25 
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6.12 Page Breaks  
 

MS word software classifies page break as soft and hard page break. A hard page break forces 

the printer to stop printing on the current page and resume on new page. The hard page break is 

displayed with a dotted gray line with Page Break written on the line, when document is 

displayed in the Draftdisplay mode. If you could not see page break in draft mode then use Ctrl 

+ Shift + 8 shortcut to display page break in the document. The soft page break is automatically 

inserted once you reach to the bottom of page, while typing a document. The soft page break is 

denoted by dotted line across the document when document is displayed in Draft display 

mode.Options to change the display mode are available in the status bar, on the right side, near to 

zoom barand it is also available in View tab under the Document Views sub group. Thesoft page 

break is automatically repositioned with addition or deletion of contents in the document. Hard 

page break remain at the same position, where it is inserted in the document. You can insert hard 

page break by Breakoption under Page Setup sub-group of page Layout tab of ribbon or you 

can use shortcut keys Ctrl + Enter at the position of inserting a hard page break in the 

document.  

 

6.13 Customize the display of ribbon and behaviour of MS word  

You can customize the features and behaviour of the MS Word software through the Word 

Option command under the Office Button menu. Click on the Office Button , and then click 

on the Word Option in the last line next to ExitWord option. You will get Word Options 

window on the screen as shown in fig 26 

 

Fig 26 

Features of MS-Word, which can be customized by users, are grouped under the following 

headings on the left vertical pane of window. The coverage of various group are as follows: 

Title of tab Features covered by the group 

Popular Personalize work environment such as language, colour scheme, user name, 

mini-toolbar and open e-mail attachments.  

Display This group allows customizationof the display of documents on screen and 

printouts.  
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Proofing  This group defines behaviour of the MS Word, when it encounters spelling and 

grammar mistakes during typing (autocorrect). It also decides the behaviour of 

MS Word when you perform the spelling and grammar checking, whether you 

want to confine to check spelling, grammar and/or styles in the documents.  

You can customize dictionary and add new words to it. 

Save  This group controls behaviour of computer during saving of the documents. It 

also define behaviour of the software during auto-saving of documents and 

destination for saving documents during auto saving.     

Advanced  This group allows to customize behaviour of software during editing, copying, 

pasting, saving and printing of documents.  

Customize This feature is used to add or remove commands from the Quick Access 

toolbar. Commands used frequently can be add to the Quick Access toolbar.  

Add-ins  This group displays and controls behaviors of applications compactable with 

MS Office.  

Trust centres This group ensures safety and protection of documents and computer from 

virus and unauthorized access. 

Resources  This group manage live update behavior of the software and find online 

resources about MS Office, which are recommended by the Microsoft  

 

6.14 Insert Graphs and Pictures in documents 

You can insert graphs, pictures, drawings and watermarks into your documents with the help of 

Insert tab of the ribbon. You can insert picture by taking cursor to the position where picture is 

to be inserted and then clicking on Picture icon  of the Illustrations sub-group, you will get 

the following dialogue window to insert picture.  Browse folder and select picture to be inserted 

by clicking over it and then click on Insert command button.  

 

Fig 27 
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The ClipArt(  ) option under Illustrations sub-group of the Insert tab is used to insert 

images, graphics and drawing. The ClipArtoffers a gallery of images and drawings;it is an 

integral component of the MS-Office. The gallery archive frequently used drawings and icons. 

Some of the components of the gallery are installed as an integral component of the MS Office, 

for other component of gallery, you have to get it over the internet. Click on ClipArt Icon on the 

Illustrations sub-group under the Insert tab, you will get the following window on the right side 

of the document window. This window is titled as Clip Art. The collection of Images under the 

ClipArt is classified into various groups for convenient and fast surfing of clipart gallery. You 

can view images from a specific group by selecting that group from the listing of Search in: 

combo box. Insert a specific image by clicking over it. The image is inserted at the position of 

the cursor. 

 

Fig 28 

You can insert mathematical formulas in the document by clicking on  Equation icon under the 

Symbols sub-group of the Insert tab of the ribbon. Equation Tool stab appears on the ribbon as 

you click over this icon. Different features of Equation Tools tab assist you in writing equation. 

Mathematical equations are rarely used in documents prepared by a secretary therefore this 

function is not discussed in details. 

 

Fig 29 
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The SmartArt option ( ) of the Illustrations sub-group of theInsert tabis a collection of 

graphics and symbols, which are used to draw flow chart, organization structure, timelines, 

processes etc.Click over the SmartArt icon results in following window.  

 

 
Fig 30 

 

Drawings of the Smart Art are classified into various groups, listed in left side pane of window. 

Select the specific group by clicking over it, the corresponding drawings from that group are 

displayed in miniature form in the middle window and the right side window display the preview 

of the selected drawing from the middle portion. Select appropriate drawing by clicking over it 

and press OK command button to insert it in the document. The SmartArt option is explained in 

details in the units of PowerPoint of the course. 

 

You can resize and rotate images and graphs inserted in the document, by clicking over the 

picture. Once you click over a picture, it is enclosed in a frame of solid line with circular dots at 

the corner of the frame, rectangle dot at the middle of the line and a yellow dot on the upper side 

of the frame out of dotted rectangle. 

 
Fig 31 

 

The Yellow circle over the top corner of the frame is meant to rotate the picture. Click and drag 

the yellow circle to get proper rotation of the picture. Other circles and rectangles of blue colour 

on the surrounding rectangle frame are meant to resize and reshape picture. Click and drag over 

one of the rectangular or circular dot of the frame to resize image. Dragging of the circle at the 

corner of dotted frame changes the size of picture, but it retains the aspect ratio of the picture, i.e. 
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height to width ratio remains unchanged after resizing. The dragging of the rectangular dots in 

the middle of lines of the frame changes size and shape of the selected picture. Double click over 

the picture, which you want to edit, resize and rotate. You will get Picture Format Tools in the 

ribbon area to format picture. 

 

 
Fig 32 

 

The commands and functions in the picture tools tab are clubbed into four groups i.e. Adjust, 

Picture Styles, Arrange and Size. The adjust sub group have commands to change brightness, 

contrast and colours of the picture. The Compress pictures option reduces size of picture so that 

document can be senteasily over fax and e-mail to recipient. Click on this icon results in a 

window reflected on the left side of the Fig 33. If compression is to be applied, only to select 

picture that click the check box titled Apply to selected picture only option in the dialogue box. 

Click on the Options command button results in a dialogue window shown on the right side of 

the Fig 33. Decide the nature of compression on the basis of whether documents are to be 

displayed on the screen, print or sent by e-mail. The document sent by E-mail is highly 

compressed.  

 

 
Fig 33 

 

Change Pictureoption of the Adjust sub group is used to change the existing picture. You will 

get a dialogue window to replace the existing picture with new one.The Picture styles sub-group 

has a gallery of the predefined styles to improve the display of the selected picture. You can 

define picture shape, border and effects.  The Picture Effectsoption of the Picture Styles sub-

group adds shadow, glow, reflection, soft edge and 3-d rotation to your picture.   

The Crop options ( ) of the Size subgroup trimsunwanted portion from the selected images.  

To trim unwanted portion of the picture, click over the Crop icon, the cursor change to . 

Take mouse cursor to the border of picture, its shape change to either of,  Γ, , , or  

depending on which corner of the image is touched by the cursor now drag cursor to remove 

unwanted portion of the picture.  
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6.15 Insert Watermark in the document 

 
A watermark is a translucent image that appears behind the primary text in a document. It is 

mainly used to insert logo of the company.  To insert a watermark 

 Click the Page Layout Tab in the Ribbon, 

 Click the Watermark Button in the Page Background sub group and get the following 

window 

 
      Fig. 34 

 

Select one of the five predefined layouts to set watermark in the document. If predefined 

watermarks do not meet your requirements than click on Custom Watermark and create 

your own watermark. 

 

 
Fig. 35 

 

Picture can be inserted as watermark by selecting on Picture watermark radio button and click 

on select picture icon. Select the picture for the watermark. The Scale: option zoom the picture 

to specific % of original size of picture.Select the Washout check box to lighten the picture so 

that it does not interfere with text, on the foreground. You can remove a watermark by clicking 

over Remove watermarkoption from the dialogue window shown in the fig 34. There are 

options to set colours (Page Color) and border of the page (Page Borders) bellow the 

Watermark option in the Page background sub group. Coloured pages are useful, when you 

upload pages on web or take printout, of voluminous documents over coloured printer.  Printouts 

with Coloured background can be easily identified in a voluminous document. 
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6.16 Design Cover Page 

Youare always keen to design an attractive cover page for your reports. There arevarious 

predefined layouts to design the cover page of the reports under the Pages sub-group of 

theInsert tab. Click over Cover Pageoption under the Pages sub group,to get readymade 

templates to design cover page. Select one of the ready-made templates and modify it to design 

the cover page for your documents. 

 

Fig. 36 

MS-Word inserts a page automatically as you reach to end of the page length, while typing in a 

document. Blank page can be added manually.  First, take cursor to position, where you want to 

insert a page, click on Blank Pageoption under the Pages sub-group of the Insert tab to insert a 

blank page manually. 

6.17 Macro  

A macro is defined as a series of commands and instructions, those are grouped together as a 

single command/programme to perform a specific task automatically.  Macros are used to 

expedite the editing and typing of documents by performing routine work automatically.  You 

can record a macro by  

 Click the View Tab on the Ribbon  

 Click  on below Macros icon of Macros sub group 

 Click Record Macro option, you will get a window to write macro. 

You need to acquire good programming skill for writing macros. Therefore, designing of macro 

is beyond the job responsibility of a secretary. Here, we have introduced you with the concept of 

macro.  
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6.18 Mail merge  
 

The MailMerge is a quick and easy way to send the same letter to a number of people, without 

typing it again and again for each person.  You can draft personalizedletter for individuals by 

merging content of letter with address database. The address database store information about 

address of individual receivers. Mail Merge can also be used to prepare address envelopes, 

mailing labels, phone directory apart from individual letter.  

The Mail Merge procedure is explained with the help Mail Merge Wizard. This procedure is very 

helpful for students who are new to mail merge. The Step-by-Step Mail Merge Wizard 

offersimmediate assistance at each step and makessuggestions for the next step.Once you are 

well conversant with mail-merge wizard, you can easily create mail merge without the wizard. 

Click on Mailing tab, of the ribbon click on arrow key () next to Start Mail Merge icon, click 

on Step by Step Mail Merge Wizard option to initiate the wizard.    

 

 

Fig. 38 

This procedure takes six steps to complete the mail merge. In the first step, computer will ask 

what type of documents you would like to prepare. 

 

 

 

 

 

 

                                                           Fig. 39 

Selected document may be letters, e-mail messages, envelopes, label or Directory. Once you 

selected type of document, click on Next: Starting document option at the lower corner of 

dialogue box to move to next step. The next step will ask how do you want to design your letter.  
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One of the options is to use the current document, you have been working. If you have already 

designed a template to customized mail merge then select Start from a template option and 

select appropriate template by browsing through templates supplied with the MS office or 

designed by you.  For current exercise, select Start from a template option. This brings up a 

link Select template in the Window, Click on this link will bring dialogue window displayed on 

the right side of Fig 40. 

 

Fig. 40 

Once you select a template of your interest, click on Next: Select recipients link, the next step is 

to decide recipient of the mail merge letters.  

 

Fig. 41 
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You can opt to use existing database or create a new database of recipients. You can also use 

contact list maintain by the MS Outlook. If source data is already available on computer then 

selectUse an existing list option, and click on Browse link,a window will appear on the screen 

to choose the source of data for the mail merge.   

 

Fig. 42 

Decide the type of source file by clicking over All Data Source combo box, a list of different 

formats supported by mail merge will appear, select one of the formats. The window displays all 

the sources from the selected folder in the format specified by you. Here, we have used an excel 

file to do mail merge, you can also use database, text, word documents etc. as source for mail 

merge. We click on the source excel file and then click on Open Command button.The Excel file 

selected by us has three worksheets named as Sheet1$, Sheet 2$ and Sheet3$, these are listed in 

next window titled as select table and prompt us to select one of the worksheet as source of 

information about recipient. 

 

Fig.43 

Select the sheet and click on OK command button.  You will get next window displaying all 

records from the selected worksheet. A single row of the excel sheet represents record of single 

recipient. All records are displaced with tick mark in the check box for each record. Tick mark in 

check box indicates that specific records are included in the mail merge. 
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Fig. 44 

If you want to skip specific records from the mail merge then clear check boxes of these records. 

If there are thousands or more records then it is impossible to clear check boxes of all unwanted 

records manually. You can skip records with specific values or features by using Filter 

command. When you click on Filter option, you will get the following Filter and Sort dialogue 

window. You can set the filter condition to make listing of recipient more precise.    

 

Fig.45 

 Suppose we want to send letters to customers situated in Delhi through mail merge then the 

Filter and Sort dialogue window will looks like as shown in fig. 46. The field: textbox specifies 

attribute or title of field of the records, where filter criteria is to be applied. Comparisons: 

textbox specifies the logical operation such as less than, equal to or greater than etc used to make 

comparison and Compare to: textbox specifies the value of the attributes to set the filter.Click 

on OK Command button to apply the filter criteria. 

 

Fig. 46 
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The next step will ask you to write letter or message to be sent to the customers. You can also 

use template to adapt predesigned text and formats in drafting of a new letter.  You may also 

select one of the options from Address block, Greeting line or Electronic postage. These 

entries add the address of customer in a prescribed manner in the letter.  

 

Fig. 47 

Here I have selected Address block option and get the following window.  

 

Fig. 48 

You can customize the display of name and address of recipients in each letter. Once you finalize 

the letter and insertion of fields from the source in the letter. Check on OK button. Click on 

Next: Preview your letters link to preview the letter resulted from the mail merge wizard. Once 

you are satisfied with the preview of letter then take the next step (5
th

 step) to complete the mail 

merge. The following window will appear. 
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Fig. 49 

Click on the Edit individual letters option to preview and edit individual letter on screen or you 

can take printout of mail-merged letters by selecting Print option. Before displaying letters on 

the screen or taking printout,this dialogue box appears on the screen to set numbers of letter you 

want to edit or print. You can display or print all the letters, current letter and specific letters by 

specifying the range in From and To textbox.    

 

Fig. 50 

Click on OK command button to finish the mail merge. 

 

6.19 Let Us Sum Up 

 

This unit covers the advanced features of the MS Word. This unit explains the procedure to 

insert picture, images, ClipArt and SmarArt in a document and functions to improve their display 

in the document. You can design header and footer areas of document. Header/footer is designed 

only once; however contents of the header and footer areas are displayed on each page, when 

document is printed. You can embed a Watermark icon, as background of document. You can 

use mail merge facility to write individualized letter to large number of customers without typing 

letter for individual customer. You can also use this facility to print address labels.    

 


